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Focus and Goal of Presentation
• This presentation is all about saving time

• Working more efficiently and effectively

• Most of us wear many hats and time is a precious commodity.

• Each year our workload gets heavier; requiring more and more time to 
get the job done.

• Every minute counts, every second counts.
• Don’t laugh; it all adds up.

• Over time, minutes add up to hours.

• None of us like working overtime.

• It is the old adage, work smarter instead of harder.

• You may know some of the items in this presentation but some people 
may not.



• I think sometimes we all feel like this!





Date Format at Beginning of File Name
• To organize files and folders by date, use the date format at the beginning of the file 

name or folder as YYYY-MM-DD.

• This file format always keeps files and folders in date order.
• Be sure to use two digits for the month and day to ensure 

files stay in date order.



Windows Explorer Quick Access Folders
• Add folders to Windows Explorer window for quick access.  This saves steps and mouse clicks.

Right click on any folder that 
you want to add to the 
“Quick Access” that is on the 
left side.  Then click on “Pin to 
Quick access”.



Organization of File Folders
• If you want to start saving things and stop printing, the key is 

ORGANIZATION of folders.
• To organize file folders think of them as you would for 3-ring binders 

and dividers or vendor file folders.
• Organize by fiscal year.
• Always set-up folders in the same order with the same descriptions 

each fiscal year to make it easy to find things.
• Most of your file folders for each year will be the same as previous years.
• To save time, set-up your folders for the year and then save these folders in 

another location to be used as a template for future years.
• With these folders set-up you can just copy the folder listing into each 

new fiscal year.
• Just check your current fiscal year folders for a few folder changes that 

may need made.



Organization of File Folders (contd.)

• Set-up file folders with dates in the YYYY-MM-DD format at the 
beginning of the folder name.  This will keep folders in date 
order.

• All of my documents are on my hard drive that I back up to 
an external drive and keep at home so it is not in the same 
place as my computer most of the time.

• All of my documents are on the OneDrive except the current 
year since the OneDrive is too slow to work from and can’t 
handle the complexity of our Excel files.



Organization of File Folders (contd.)

• Deeds
• GPS Coordinates for all 

WV schools
• Manuals
• Templates
• Letterhead
• Maps
• Vehicle Registration Cards

• Property
• School Bank Accounts
• School Floor Plans
• WV State Code Sections
• VPN Set-Up

• Because, lol, you can’t ever 
remember how to set it up 
again.

• WVEIS Manuals
• WVEIS Settings, etc.

Most everything I save is under a fiscal year, however, there are some things 
that don’t fit into a fiscal year category and saved under (just a partial list):



File Folder Organization Example



Pin Programs to Task Bar for Easy Access

Left click on Windows icon in bottom left corner of screen.
Find the program to pin to task bar.
Left click on program and hold then drag to task bar.

You can also rearrange the programs on 
the task bar by left clicking on program 
and holding then drag left or right.



Pin Files to Task Bar Programs
• When you have programs pinned to the task bar you can right click on 

the program to see recently viewed files.

To pin files to the program, look under “Recent” for 
the files recently used, then click on the thumb tack 
to the right.  This will pin the file to the program.



CalcTape – Free Program

• A handy free program to use 
instead of an adding machine is 
CalcTape.  I can’t tell you the last 
time I used the adding machine 
on my desk.

• CalcTape can be used run a 
tape, can be printed and can 
even be saved.  There is also the 
feature to add text descriptions, 
as well.

• It can be downloaded at 
http://download.cnet.com/CalcT
ape/3000-20417_4-90456.html

http://download.cnet.com/CalcTape/3000-20417_4-90456.html


CalcTape Saved 
File with Text 
Descriptions

When you save the 
file, the file name 
becomes the tab 
name.



Email Organization

• Organize emails by fiscal year.
• Always set-up folders within each fiscal year the 

same.
• This will make it easier to find an email when the 

search feature returns too many possibilities or you 
aren’t searching on the correct wording.



Quickly Spot Folders in Microsoft Outlook
• Microsoft Outlook still does not permit changing the color of 

a folder.  A work around can be to use special characters 
in the built-in windows application “Character Map”.



Quickly Spot Folders in Microsoft Outlook (contd.)
• In the Windows search box type, “Character Map” and choose “Character Map” Desktop 

app.



Quickly Spot Folders in Microsoft Outlook (contd.)
• With the Character Map window open, copy the character that you want to use.



Change File Type of Incoming Emails
• In Outlook, select “File”, then “Options”.
• Select “Trust Center” in the left pane.
• Select “Trust Center Settings”, then “Email Security”.
• In the “Read as Plain Text” section, deselect the box for “Read all standard mail in plain text”.



Cascading Emails

• Cascade emails to 
show all related emails 
in a string.

• In Outlook, go to File, 
then Mail, then under 
“Message format”, 
check the “Use 
Cascading Style 
Sheets (CSS) for 
appearance of 
messages”.



Cascading Email Example

All of these 
emails are 
organized 
and tracked 
together 
based on the 
email 
conversation



Preface Email Response Comments with Your Name

• In Outlook, go 
to File, then 
Mail, then under 
“Replies and 
forwards”, 
check the 
“Preface 
comments 
with:” and type 
your name in 
the blank field.



Example of Preface Email Response



How to Edit/Make Notes on an Email Already Sent
• When you need information/responses from many people it can be cumbersome in tracking responses to ensure 

information has been provided by everyone.
• Open the already sent email in Outlook then click on the dropdown for “Actions”, select “Edit Message”.  Then type 

anywhere in the email.  You can also edit the font on anything in the email.  The edited email is only seen by you; 
Outlook doesn’t send the edited email to the recipients.

The red text is my edits 
to track responses

Editing emails is an 
easy way to 
document / track 
verbal responses from 
phone conversations 
as well.



Outlook Quick Parts
• We often type the same or very similar responses when replying to emails.

• To save time, save these phrases to Quick Parts.

• Highlight the text that you want to add to Quick Parts, then click on Quick Parts, then Save 
Selection to Quick Part Gallery.

Highlighted text

Save



Outlook Quick Parts (contd.)

• This next screen comes up to save your phrase.  In the top field “Name” 
give the phrase a description.  Then click OK.



Outlook Quick Parts (contd.)
• To use a previously saved Quick Part, click On Quick Parts and a listing of 

saved Quick Parts appears, click on the phrase that you want to insert.



Outlook Quick Parts (contd.)
• Since getting to “Quick Parts” in the toolbar is cumbersome and too many steps, you can 

add “Quick Parts” to the Quick Access Tool Bar that is at the very top of emails.  To add, right 
click on “Quick Parts” and choose “Add to Quick Access Tool Bar”

Right ClickShows up here





My Tasks Screenshot



Outlook Tasks
• Use Outlook tasks to keep track of deadlines and reoccurring tasks.
• You can create the task or you can flag an email that will create the task with a specified 

date.
• You can also delegate a task to someone else and Outlook will send the task to the individual 

and add the task to their own tasks.
• To make a task directly from a received email, click on Follow Up, then choose from the 

dropdown.  The Custom will allow you to choose a specific date and time.



Reoccurring Task
Click on Tasks icon at 
bottom

Click on “New Task”



Assign a Task to Someone Else
• You can delegate or assign a task to someone else by forwarding (or replying) to an email to 

the individual and under the Follow-Up tab choose Custom, then click the box for Flag for 
Recipients.  Click Reminder for you or the person that you are assigning the task to for 
Outlook to remind them on a certain date and time.



Assign a Task to Someone Else (contd.)
• You can also assign a task that is currently in your task list to someone else.

• Open the task pane, click Assign Task, fill in the email address and click Send.





Email Templates
• Many of us send repetitive emails.  To save time create email templates.  This saves time; 

every second counts.
• Save your email templates in an Outlook folder in your Favorites for easy access.
• To use your email templates, click on the folder and then double click on the email that 

you want to use; this will open the email.  If no changes need made just hit send.  DONE! 
And you didn’t have to type the email!

• Instructions on next page to set-up.

Set-Up Email 
Template 
folder under 
Favorites for 
easy access



Email Template 
Instructions

See next slide for screen shot of 
how to drag this file



Email Template Instructions (contd.)

• This is the path that Microsoft Outlook 2016 will probably use to save the email template.
• C:\Users\ahughart\AppData\Roaming\Microsoft\Templates
• You may want to choose another location to save the template.



Email Template

This is my 
email 
template 
opened

NOTE: If you have your 
email set to automatically 
include your Name, 
Address, etc. make sure it 
is NOT on the template 
when you save it since 
Outlook will add it when 
you open the email 
template.



Task Plus Email Template with Formulas in Email for Text 
and Calculated Dates

• This is my reoccurring task for a monthly email to our school secretaries to remind them that 
their previous month financial reports are due to me by the 10th of the month or the first 
business day thereafter.

Notice there is an 
attached item; this is 
an Email Template



Task Plus Email Template with Formulas in Email for Text 
and Calculated Dates (contd.)

• You can attach just about anything to a task.
• While in the Task go to Insert and choose the type of item you want to insert: 

File, Outlook Item (can be an Email Template), business card, etc.
• This example is to attach an Email Template.
• Go to Insert, then Outlook Item:

Task Pan



Task Plus Email Template with Formulas in Email for Text 
and Calculated Dates (contd.)

• This is the screen that opens.  Find your Email Templates and choose the Email Template that 
you want to attach and click OK.



Task Plus Email Template with Formulas in Email for Text 
and Calculated Dates (contd.)

• This is the attached Email Template that I created and is my Outlook Email 
template folder.



Task Plus Email Template with Formulas in Email for Text and 
Calculated Dates (contd.)

• When it is time to perform the task, open the task window and double click the attachment 
(this will be your Email Template that opens), make any needed changes and hit send.  
DONE!

• But wait we can take this a step further.  In your Email Template you can insert an Excel 
worksheet for calculations and text.

• Again this is my Email Template that I attached to the Task:

Notice this line looks 
like text but it is an 
Excel spreadsheet 
with a formula for 
the text and 
automatically 
calculates the first 
business day that is 
after the 9th of the 
current month



Task Plus Email Template with Formulas in Email for 
Text and Calculated Dates (contd.)

Dates will 
automatically 
update 
based on the 
formula when 
the Email 
Template is 
opened and 
you double 
click on the 
Excel portion.



Email Formula
• A Concatenate formula will allow you to string multiple fields of text together but will not 

allow you to imbed formulas with the text strings. 

• Let’s take a look at that Excel formula a little more closely.

• This is an interesting formula that will allow you to string text and formulas together.  The text 
sections are in quotes, then to join each section there is a SPACE and an & sign together. 

• ="This is a reminder that the schools' " &TEXT(EOMONTH(TODAY(),-2)+1,"mmmm yyyy") &" 
Financial Reports are due to me by " 
&TEXT((DATE(YEAR(NOW()),MONTH(NOW()),10)+CHOOSE(WEEKDAY(DATE(YEAR(NOW()),MON
TH(NOW()),10),2),0,0,0,0,0,2,1)),"dddd, mmmm dd, yyyy") &".“

• The formula populates in the email as:
• This is a reminder that the schools’ February 2017 Financial Reports are due to me by Friday, March 

10, 2017.
• Again when the email template is opened, all of the date references update automatically 

based on the current date.

See the SPACE& together?



Compose an Email to Send at a Future Date
• Compose an email and set it to send at a future date and time.  In your 

email, go to Options, then Delay Delivery.



Compose an Email to Send at a Future Date (contd.)
• When you click on Delivery Delay, a Properties box pops up.  Now select the 

date and time for the email to be delivered.

Click Close



Compose an Email to Send at a Future Date (contd.)
• Now click Send on your email.

Delay Deliver box 
becomes greyed 
when Properties 
have been 
saved.



How to Find an Email Set to Send in the Future
• Emails set to deliver in the future, appear in your Outbox.  So you can easily see if you have 

already created the email or if you need to reopen the email to make changes before 
Outlook sends the email.



To a New Email, Attach a Previous Email
• In a new message, select Attach Item.
• Choose Outlook Item.
• Then find and select the email to attach.



To a New Email, Attach a Previous Email (contd.)
• Find the email to insert.



To a New Email, Attach a Business Card
• If you have your contacts set-up in Outlook, you can attach a business card 

to an email to send to someone else.



Excel 2016 Shortcuts Listing
• This is a link for all 253 Excel 2016 Shortcuts 

https://shortcutworld.com/export.pdf?id=bc6RlDKUj
9iZOphpSBQiOhHqnRpo8PNkAb2fLmg%2BczQ%3D

• The listing is more than you will ever use but some 
are handy.

• Strikethrough is something I use frequently.  Did you 
know that Control+5 will strikethrough or un-
strikethrough?

https://shortcutworld.com/export.pdf?id=bc6RlDKUj9iZOphpSBQiOhHqnRpo8PNkAb2fLmg%2BczQ%3D


Customize Excel Quick Access Toolbar

• Click on the little down arrow in the top left 
corner of Excel.

• Then click Customize Quick Access Toolbar.
• Then add any functions that you may want 

easy access to.
• You can see above that I have added Save, 

Undo, Redo, Print Preview, Quick Print and 
Strikethrough.



Excel Number of Default Sheets in New Files
• Excel, I think, defaults new files to only have 3 sheets.
• Sometimes you need more sheets than 3.  So to save time and keystrokes change the default 

for number of sheets in new files.  If you don’t use all of the sheets in a new file, it doesn’t 
matter.

• You can change the number of Default Sheets in new files under Excel Options, General, 
“When creating new workbooks”, then in the field “Include this many sheets:” change the 
number.  I have mine default to 15.



Excel Listing of Recent Files
• In Excel you can see a listing of recently used files by using ALT+F or clicking on File in the top 

left of the screen.
• Excel defaults to a low number of recent files to display.
• You can change the number of recent files to display by clicking on File, then Excel Options, 

then Advanced, under the Display section change “Show this number of Recent Workbooks:”  
I have mine set to 25.  It saves time.

• If you have ever saved a file and then can’t find it, this may help so that you can open the file 
and save it in the correct location.



Excel Listing of Recent Files Screenshot



Watch Window
• Our year-end financial statements is a perfect place to use a “Watch Window” in Excel.
• There are many, many, many cells throughout the spreadsheet that have to balance to 

zero.  It is a real pain going from sheet to sheet to sheet, etc. trying to find all of the cells that 
have to balance to zero.  This last round of the financial statement template was even 
worse for this issue.

• An easy way to see if all of the cells are balancing to zero is through a Watch Window.
• The Watch Window is created from the Formulas tab.

• The next slide is a video of a Watch Window in our year-end financial 
statements.








Watch Window (contd.)
• The cool thing about a Watch Window is that it can be moved around.
• It can be on the top.
• It can be floating on top of your Excel File window
• It can be moved to a different monitor than Excel is on.
• Every time you make a change in your financial statements you can see in 

the watch window what the immediate affect is throughout the financial 
statements.

• The cool thing about a watch window is that you can click on an item in 
the watch window and it will take you directly to that particular cell on that 
particular page.

• It is the happiest feeling when all of your items in the watch window are 
$0.00 and everything balances.

• No more searching from screen to screen to see how the change affected 
everything.



How to Unprotect Multiple Worksheets at Once in Excel
• You can use VBA for this even if you don’t understand the coding.
• I use this for our year-end financial statement file.  It does work!

The password for our 
FY2016 year-end financial 
statement Excel file was 
“BOE2016”.  You would 
enter “BOE2016” in the 
box.



Excel AutoFit Column Width
• When you build an Excel file that you reuse sometimes the column width needs adjusted due 

to more digits in a number or text length.
• You can have Excel AutoFit the Column Width so it will automatically adjust.  This saves time.  

It works most of the time.  Every once in a while a column may need adjusted by hand for 
some reason.

Click on Format, then 
AutoFit Column 
Width.

You can also AutoFit 
Row Height.





Format Multiple Excel Sheets at the Same Time
• Sometimes when you build a file each sheet is set-up 

identically.

• It can be cumbersome to format a file with a lot of sheets.

• You can highlight all of the sheets and then format all of the 
sheets at one time.

• Click on the first sheet in the bottom bar of Excel then scroll right 
to find the last sheet.  Hit Shift and left click on the last sheet to 
be formatted.

• Perform the formatting.

• Then scroll left to the first highlighted sheet, Hit Shift and left click 
on the first sheet.  Done!



Excel Sheets Listing

• When you have an Excel file with 
numerous sheets, instead of scrolling left 
and right to find the sheet that you need, 
go to the bottom left of your screen and 
hover over the left and right arrows, then 
right click, this will pull up a listing of all of 
the sheets in your file.  From this window 
listing left double click on the sheet that 
you want to go to.



Excel Sheet Listing (contd.)

This is the sheet listing from our 
year-end financial statement 
file.  
Double left click on the sheet 
that you want to go to.
You can also scroll in this 
window.



Conditional Formatting
• Conditional formatting can be helpful to highlight and/or change the color of Excel cells 

based on certain criteria.
• This is an example of conditional formatting to change the formatting of cells where there was 

a change of 30% or more.

For background: We had multiple bus runs that were 
being reconfigured during this personnel season.  If a 
bus run changes by 30% or more then the driver must 
be put on transfer.  The driver may request a hearing.



Conditional Formatting (contd.)
• To apply Conditional Formatting highlight the cells that you want to apply 

the formatting to.  Then on the Home tab, click on Conditional 
Formatting.  A dropdown will appear with many options.



Attaching a Screen Shot
• You can attach a current screen shot of any open window on your desktop in Excel, Word, 

Outlook and PowerPoint or you can also attach a screen clipping that was previously saved.

• Click on the Insert tab, then click Screenshot.  This will show a dropdown of mini pictures of 
windows currently open on your desktop.  Click the picture of the window that you want to insert 
or choose Screen Clipping and find the file to insert.

Windows that are 
open on my 
desktop.



Cropping a Screen Shot or Picture
• Any picture that is inserted into Excel, Word, Outlook and PowerPoint can be cropped and 

resized.

• Click on the picture and a Picture Tools tab will appear at the top of your screen.  Click on 
the Picture Tools tab, click Format, then Crop.

• The screen of your picture will change to a greyed color and little paddles will appear on 
the top, bottom, left and right and corners (see next slide).
• For those of you that remember Pong, the paddles look like Pong paddles.

• Left click and hold on a paddle and move your mouse to crop out areas.  When done click 
outside the grayed area.



Cropping a Screen Shot or Picture (contd.)



Building Formulas 
• Formulas with multiple parts are usually trial and error for all of us.
• When trying to build a formula with multiple sections or formulas 

imbedded into other formulas, it can be helpful to build each section in 
a separate cell to aid in determining that that particular section works 
without an error.  Once each section has been built separately then try 
to nest them together.

• If you have a nested formula that is causing particular grief, Open Word
and change the orientation to Landscape and then change the paper 
size to Legal or Ledger (even wider), also make the left and right 
margins really small.

• Then copy the formula into Word and step it out, either on multiple lines 
with spaces in between each section.  Sometimes this helps you to 
visually see where the problem is.  When a formula is all scrunched 
together it can be difficult to see where the problem is.



Building Formulas (contd.)
• This is a simple formula as an example:

Original Formula

Formula with spacing

Formula stepped out on 
multiple lines for each 
section



Building Formulas (contd.)
• In Excel we have all used the Excel help with building formulas by choosing a formula then 

Excel steps you through a formula with the Function Arguments window.

• This Function Arguments window is another tool to use try to determine where a problem is in 
a formula.

• Place your curser on the cell where the formula is and then click on the Formula tab, then 
Insert Function.  This will bring up the formula Function Arguments.  From the Function 
Arguments window you may be able to see which section may be causing the error issue.



Building Formulas (contd.)
• On the Formulas tab, you could also use Evaluate Formula to assist with a 

formula issue.

• With a complicated formula, this can help with determining which section of 
a formula may be the issue.



Excel Formula Cell Expansion
• When building formulas, expand the formula cell so the full formula shows and 

is not cutoff.

• Just drag down on the bottom of the formula cell to expand.

Drag down



Excel Formula Cell Expansion (contd.)

Formula cell extended to 
show entire formula



Clipboard
• Copying and pasting a lot of different things can be tedious.
• In most Microsoft programs clicking Ctrl+C twice will bring up the 

Clipboard.
• The Clipboard will allow you to copy many items to the Clipboard 

and then use them when needed.
• The items on the Clipboard don’t disappear when used.  The items 

are only removed from the Clipboard when you clear the items.
• One of the interesting things about the Clipboard is when multiple 

Microsoft programs are open on your desktop that the Clipboard 
appears in each program with items copied from different programs.

• I was able to get the same exact Clipboard to show up on Excel, 
Word and Outlook that were open on my desktop.



Clipboard (contd.)

• This is the screen shot 
of the Clipboard in 
Excel.

• Notice that there are 
items from PowerPoint, 
Word and Excel on the 
Clipboard.

• The Clipboard is 
identical in Excel, Word 
and Outlook.



Clipboard (contd.)

• To have the Clipboard 
show automatically, 
open the Clipboard by 
clicking Ctrl+C twice, 
then at the bottom of 
the Clipboard window 
left click on Options, 
then check beside 
Show Office Clipboard 
Automatically.



Excel Templates (contd.)

• AJE's (right click and select 
Open Hyperlink)

• BJE's (right click and select 
Open Hyperlink)

• WV Municipal Bond 
Reconciliation

• Indirect Cost Transfers 
Calculations

• Monthly Board Financial 
Reports

• Bank Reconciliations
• Utility Reports
• Budget File
• Budget Reconciliation
• Indirect Cost Calculations
• Faculty Senate 

Distribution
• On and on and on

• We all know it is about working smarter instead of harder.

• If you have something that is reoccurring, create templates in Excel.

• I have a lot of templates that I have built over the years.  It saves so much time.

• Some of the templates that I have built over the years are:



Remove Duplicates in Excel
• There may be times when you want to Remove Duplicates from a large amount of data.



Remove Duplicates in Excel (contd.)
• When downloading reports from WVEIS, sometimes WVEIS will list the first row on a page that 

is a duplicate from the last row of the previous page.

• This can be a problem if you are trying to run the data through a pivot table.

• Most of the time, WVEIS prints the header with “** Continued **” as follows:

• But it is WVEIS and sometimes it has a hiccup and doesn’t print the **Continued**.
• This is the bottom of page 68 of our Budget Forecasting Account Distribution by Account report:

• This is the top of page 69, WVEIS missed the **Continued**.



Remove Duplicates in Excel (contd.)
• If the duplicate information isn’t removed, a pivot table will 

count the information twice since there isn’t the statement of 
**Continued** to be able to exclude these cells through the 
Pivot Table.

• Without the duplicates removed a Pivot Table will return that 
there are 2.10 FTE in account code 11.00000.12411.121.201 
when it is really only 1.05 FTE.

• When the duplicates are removed, the Pivot Table calculates 
the correct FTE at 1.05.

• Working with large amounts of data can be easier with the 
duplicates removed.



Pivot Table Calculated Field
• If you have never used a Pivot Table before, this could make 

you take the leap.
• We all hate it when a grant award letter is issued with a different 

dollar amount than we received as an estimate when we built 
our budgets.

• It is usually easier to reverse out the whole budget and then re-
enter the new budget instead of trying to figure out the amount 
of difference for each budget line.  But this is a lot of work!

• A Pivot Table Calculated Field can assist with this process.
• I think all or most of us enter our Title I budgets down to the 

location code.
• We will use Title I as an example.



Pivot Table Calculated Field 
(contd.)

• This is a partial screen shot 
of Excel for the reversal of 
the original budget 
estimate with the final 
budget amounts.

• Barbour is a small county, 
therefore, our budget 
entry will be fewer lines 
than a lot of other 
counties.

• There are 140 lines in this 
example.



Pivot Table Calculated Field (contd.)
• This is a screen shot of a Pivot Table with a Calculated Field.
• Now all we have to key into WVEIS are the amounts in the Calculated Field 

which is 13 lines and not 140 lines!

• Excel Pivot 
Table 
Spreadsheet

• Double Click 
to open the 
imbedded 
Excel sheet 
and scroll 
through rows

Calculated 
Field



Pivot Table Calculated Field (contd.)

• To insert a Calculated 
Field into a Pivot 
Table put your curser 
on any cell of the 
pivot table.

• The PivotTable Tools 
tab will show up when 
your cursor is on a cell 
in the pivot table.

• Click on the Analysis
tab.  Then click on 
Field, Items & Sets.  In 
the dropdown 
choose Calculated 
Field.



Pivot Table Calculated Field (contd.)
Name the New Field 
Header

In the Formula Bar:
• Insert the Name 

of the First 
Column, “Debit 
(add to)” using 
the Insert Field 
button

• Type “-” in the 
formula bar

• Insert the Name 
of the second 
column, “Credit 
(subtract from)” 
using the Insert 
Field button

• Click OK



Build a Pivot Table
• Building pivot tables and reusing year after year after 

year will save tons of time.
• There are many ways to build and format pivot tables.  It 

is not as hard as it looks.  Pivot tables look intimidating.  I 
was hooked after the first Pivot Table I built.

• You can do so much more with pivot tables than just 
select certain data to populate in columns.  This next 
hyperlink is a good example; it is a little more complex.

• Child Nutrition balances pivot tables (to open, right click 
and then choose Open Hyperlink)



How to Correct When a Formula Returns an Error of “#REF”
• The formula of “ISERROR” doesn’t show up In Excel under the 

Formulas tab, searching in Insert Function field.

• There is always more than one way to write a formula in Excel but 
this one is pretty straight forward when built into an IF statement.

• =IF(ISERROR(+GETPIVOTDATA("Current YTD Budget",'Reserve for 
Cont. Pivot Table'!$A$7,"Fund",11)),0,+GETPIVOTDATA("Current YTD 
Budget",'Reserve for Cont. Pivot Table'!$A$7,"Fund",11))

• This is just an IF statement where if Condition 1 is an error because it 
can’t be found, then the formula returns a “0”, if Condition 1 does 
not return an error then it returns the value.

• It is just an IF statement with 3 sections just like any other IF 
statement.



How to Record a Macro

• See next page for a video of a Macro recording.








Shortcut Keys
• This is a link for Shortcut Keys https://support.microsoft.com/en-

us/help/12445/windows-keyboard-shortcuts for
• General Keyboard Shortcuts
• Windows Logo Key Keyboard Shortcuts
• Command Prompt Keyboard Shortcuts
• File Explorer Keyboard Shortcuts
• Virtual Desktops Keyboard Shortcuts
• Taskbar Keyboard Shortcuts
• Settings Keyboard Shortcuts

• A few Windows Logo shortcuts that you might use are on the 
next slides.

https://support.microsoft.com/en-us/help/12445/windows-keyboard-shortcuts






Windows Explorer Shortcut Keys that You 
May Use

• Create a new folder, “Cltrl + Shift + N” 
• Display the preview panel, “Alt + P”
• Maximize or minimize the active window, “F11”



Print WVEIS Reports to PDF Instead of Printer

• Open WVEIS printer 
session.

• Left click on File, then 
Printer Setup.

• In the printer dropdown 
choose Adobe PDF (this 
will be an option if you 
have Adobe Pro) or 
Microsoft Print to PDF.



Set-Up Dummy Files on Desktop to Print 
WVEIS Report

• Sometimes when we print WVEIS reports we don’t need to keep 
them.  We may be just checking balances or looking at account 
detail.

• Set-up dummy files on desktop to print WVEIS reports to when the files 
don’t need saved with a specific name.

• I have two WVEIS green screens and one WVEIS printer screen.  The 
dummy file names I have set-up on my desktop are the same names 
of each of the WVEIS screens:



Default Print Drivers to Print to PDF
• In the Windows search field in the bottom left hand corner of computer 

screen, type Devices and Printers.
• Double click on the Printer named Adobe PDF.
• In the Adobe PDF Printer window, click on Printer, then “Set As Default Printer”.  

This will print all programs to PDF instead of an actual printer.



Print WVEIS Reports to PDF through WVEIS WOW
• It is possible to print WVEIS green screen reports to PDF through WVEIS WOW.  I can’t take 

credit for this one, Ann Bell gets the credit for this tip.

• Run your report in WVEIS green screen and put the report on hold.

• Open WVEIS WOW and go to the “Reports” Tab and you will see the report that you put on 
hold in the green screen.

• Now click on the report.



Print WVEIS Reports to PDF through WVEIS WOW (contd.)
• This is the screen that comes up when you click on the report in WVEIS 

WOW.

Click the 
Download 
Arrow.



Print WVEIS Reports to PDF through WVEIS WOW (contd.)
• This should be the screen that comes up to save the file as a pdf.  The Save as 

type should come up as Adobe Acrobat Document.





Adobe Acrobat Files Open WAY TOO LARGE
• It used to drive me crazy to open an Adobe Acrobat file only to have it display REALLY LARGE.
• There is a way to change the zoom when Adobe Acrobat Pro opens files.
• In Adobe Acrobat Pro, go to Edit in the top tool bar, then Preferences, Page Display.  Change 

Zoom to “Fit Page”. 



Adobe Pro Bookmarks and Links
• I can’t say enough positive things about Adobe Pro.  I couldn’t live without it.

• Bookmarks are a great feature when you use files electronically.

• Our Chart of Accounts is a good example:

• Chart of Accounts (right click and select Open Hyperlink)

• Our Board Agenda’s are done in PDF using Adobe Pro with links throughout 
Ag.03.13.17.pdf

• The Educator Price for Adobe Acrobat Pro DC is $119.00, 
http://www.adobe.com/products/catalog/software._sl_id-
contentfilter_sl_catalog_sl_education_sl_alledu.edu.html?start=10
• If the $119.00 doesn’t show up on the website, call them, it is available.  Sometimes the 

monthly fee amount only shows up but you can buy it out right for $119.00.

• The program is worth the cost.  You will save that much just in paper and 
toner.

http://www.adobe.com/products/catalog/software._sl_id-contentfilter_sl_catalog_sl_education_sl_alledu.edu.html?start=10




Combining Multiple Files into a Single PDF

• The next slide is a video of combining multiple files of different types into 
a single PDF.



Combining Multiple Tiles into a Single PDF
• Now find multiple files on your computer to combine.  Pick some PDF, 

Word and an Excel file.






Adobe Pro
• To replace existing pages in an Adobe file, open the Page Thumbnails, then 

in the Thumbnails highlight the pages you want to replace (make sure 
replacement pages are the same number of pages), then right click on the 
thumbnail highlighted pages and choose, Replace Pages.

• Extracting pages from an Adobe file is done through the Page Thumbnails as 
well.  Just right click and choose Extract Pages and the highlighted pages will 
open in a separate file, then you can save the extracted pages in a new file.

• Delete pages can also be done through the Page Thumbnails.  Right Click 
and choose Delete Pages.  This will delete the pages that you highlighted in 
the thumbnail.

• Page Labels can be used to number pages through the Page Thumbnails.  
Right Click and choose Page Labels.
• I use this feature on all of my year-end work papers.  Instead of at the top where it would 

say 1 of 6 pages, mine will say A-1, A-2, A-3, etc. which correspond to other work paper 
tick marks.





Multiple Monitors
• To go paperless, you will need multiple monitors.  I have 3 27-inch curved 

monitors.
• Curved monitors flow better for the eyes and have become pretty cheap.

• Even with 3 monitors, there are times I need 6 but manage with 3.

• It is best to have all of your monitors the same size.

• It becomes cumbersome to have monitors of different sizes since moving a 
screen from one monitor to another monitor will require you to more than 
likely resize the screen to fit the monitor.

• When all monitors are the same size, you can slide a screen to a different 
monitor and not have to resize the screen.

• The next slide is a picture of my monitors.  You will notice that the center 
screen is an HDMI (clarity is much better).  I need to order adapters for the 
other two monitors to make them HDMI.



Picture of Monitors



How to Extend the Screen for a Laptop Connected to a Projector
• When connecting your laptop to a projector for a business presentation, you can 

display the screen image in a variety of ways, such as sending the image only to the 
projector or projecting the same image to both screens. However, to maximize your 
available screen area, extend your screen so the laptop and projector each display 
a portion of the overall image. Extending your screen lets you keep windows on your 
laptop screen and only drag them to the projector screen when they become 
relevant.

• Click the Windows orb on the taskbar to open the Start menu.

• Type "screen resolution" into the search box in the lower-left corner of the Start 
menu. A list of search results automatically appear on the left side of the Start menu. 
Click "Adjust screen resolution" in the list of search results to open the Screen 
Resolution dialog box.

• Click the drop-down box labeled "Multiple displays" to open a drop-down menu.

• Click "Extend these displays" to expand your screen across the laptop and 
projector.

• Click "OK" to apply your changes and close the dialog box.
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